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Introduction:

This document provides guidance on processes for managing the QOF+ indicators associated with primary
prevention of cardiovascular disease. The QOF+ CVD Primary Prevention indicators are designed as far as
possible to be in line with the recent NICE Guideline on Lipid Modification (Cooper et al., 2008):

http://bit.ly/vyG

The NICE guidance recommends that initially, “CVD risk should be estimated using CVD risk factors already
recorded in primary care electronic medical records” and that “people should be prioritised for a full formal risk
assessment if their estimated 10-year risk of CVD is 20% or more. This will consist of a formal clinical assessment
and risk factor estimation based on the measurement of blood pressure, lipids and current smoking status and
taking account of other relevant factors such as family history, ethnicity and social or clinical circumstances.”

At the time of launch of QOF+ 2008/2009, neither EMIS nor Vision provided the full ability to estimated CVD risk
of all patients as recommended by NICE. Therefore this guide explains how to use additional software (Oberoi
Clinical Observations Suite) to enable you to create a register of patients at an estimated 10-year risk of CVD of
20% and more, who you can then invite for full formal risk assessment and management.

Section 2 of this guide assumes a familiarity with INPS Vision and an understanding of the Search and Reports
module and the Patient Groups module of INPS Vision. If you are not familiar with these, you may wish to read
the INPS Vision training guides for each of these modules, which are accessible from the following site:
http://www.inps4.co.uk/my vision/training-guides/ or seek support from the IT Service Desk.

Section 3 of this guide assumes a familiarity with EMIS LV and an understanding of the Search and Statistics
module of EMIS LV. If you are not familiar with these, you may wish to search for some guidance from the EMIS
Common Room or seek some support from the IT Service Desk.

Practices are advised to identify a QOF+ CVD primary prevention lead who can take responsibility for overseeing
the processes associated with creating the CVD at risk register, coordinating the associated call and recall
processes and monitoring achievement. We recognise the processes outlined in this guide can be time
consuming and tedious. We do not expect this process will continue for future QOF+ years, as the area is rapidly
developing. For example, EMIS introduced in March 2009 a module to estimate QRISK2 scores for all patients.
We anticipate that both Vision and EMIS will continue to develop improvements in their systems to permit an
easier, integrated approach in the future.

http://www.qofplus.co.uk/more

General Enquiries: qof+@hf-pct.nhs.uk

IT Support: servicedesk@hf-pct.nhs.uk
IT Service Desk 020 8383 8655


http://bit.ly/vyG
http://www.inps4.co.uk/my_vision/training-guides/

Guide to establishing a CVD At-Risk Register using Oberoi

(versions 2.6.19 onwards have restored some limited functionality to

Code risk scores into patients’ notes)

Establish screening protocols and
nominate a clinical lead

|

Start of screening cycle (3-6 monthly)

Ve

® Generate list of patients with
estimated CVD risk > 20%,
excluding those:
* Who are on the diabetes or CVD
registers
* Who have been processed before
and already have a risk coded into
their clinical notes

l

Clinician review using patient notes
to identify possible data entry errors

(

No obvious
errors identified

v

Errors identified

e.g. BP recorded as 1400/85

Code CVD risk > 20% into clinical
system for each patient

!

Send screening invitation letter
using mail merge facility

Take appropriate action to address to
errors, for example:
* Recheck patients with erroneous
BP entries
* Add correct codes for patients who
should be on diabetes/CVD registers
Patients will be reviewed in next
screening cycle

!

Review patients and record data using
CVD prevention template

l

Appropriate clinical management

!

Monitor achievement against QOF+
CVD prevention indicators using QOF+

IT tools
v

Review patients not meeting indicators

J

® Tasks that can be completed within Oberoi



QOF+ CVD Prevention Indicators

QOF+ Payment

Indicator .
points stages

+ CVD PREVENT 1. The percentage of patients on the Practice
CVD At-Risk Register whose notes have a Blood Pressure 8 40-90%
recorded in the previous 15 months

+ CVD PREVENT 2. The percentage of patients on the Practice
CVD At-Risk Register whose notes have a record of BMI 8 40-90%
measured in the previous 15 months

+ CVD PREVENT 3. The percentage of patients on the Practice
CVD At-Risk Register whose notes have a baseline record of 8 40-90%
total and HDL cholesterol recorded in the previous 15 months

+ CVD PREVENT 4. The percentage of patients on the Practice
CVD At-Risk Register for whom there is a record of a fasting 8 40-90%
blood glucose in the previous 15 months

+ CVD PREVENT 5. The percentage of patients on the Practice
CVD At-Risk Register whose notes have a record of family
history of CHD in first degree relatives (parents, brothers,
sisters, or children of a patient)

8 40-90%

+ CVD PREVENT 6. The percentage of patients on the Practice
CVD At-Risk Register whose notes have a record of family
history of diabetes in first degree relatives (parents, siblings,
or children of a patient)

8 40-90%

+ CVD PREVENT 7. The percentage of patients on the Practice
CVD At-Risk Register who have been offered lifestyle advice on
exercise, and appropriate dietary changes within the previous
15 months

10 40-90%

+ CVD PREVENT 8. The percentage of patients on the Practice
CVD At-Risk Register who have been offered statin therapy (in
line with 2008 NICE guidance on Lipid Modification) as part of
their primary prevention management strategy

10 40-90%

It is prerequisite that in order to receive payment for + CVD PREVENT 1, practices have achieved the
existing QOF RECORDS 11 Indicator (The BP of patients aged 45 and over is recorded in the preceding 5
years for at least 65% of patients.)



Section 1:

Using the Oberoi Clinical Observations Suite
to identify patients appropriate for inclusion
on the CVD at risk register



1.1

Using the Oberoi Clinical Observations Suite to identify patients appropriate
for inclusion on the CVD at risk register

The QOF+ CVD At Risk Register is defined as those patients in the age range 32-74 without CHD or
diabetes who have anywhere in their medical records a recorded 10-year risk of developing CVD which

is greater than 20%.

In terms of Read codes, it is made up of those patients who have either of the following Read codes

entered into their records at least once:
662m. JBS CVD risk >20 - 30% over 10 years
662n. JBS CVD risk >30% over 10 years

This register will need to be set up by the practice with the aid of Oberoi software before you can
commence on the QOF+ CVD primary prevention indicators.

The following steps describe how to create the CVD at risk register:
1. Ensure Oberoi Clinical Observations version 2.6.17 or later is installed

You will need Oberoi installed on at least one PC in your practice. This might be the practice
manager’s PC or the PC used by the practice’s QOF+ CVD primary prevention lead.

If you have it installed, check that it is version 2.6.17 or later. The version will be displayed at
the very top of the Oberoi window when you open Oberoi:

(@ Oberoi Clinical Observations V2.6.14 (EMIS LV) - JB5 Risk Analysis

File Actions Patient Mail Merge  Help

oY

You can download the latest version of the software at:

http://www.oberoi-consulting.com/primaryprevention.aspx

e I he e

useful for advanced data manipulation and

Call Dberai mail merge.
Consulting on F
01832 224 231 to - A copy ofthe Installation Instructions for your

disouss your clinical systern can be obtained by emailing

requirements

admin@ ober oi-consulting.com

To download the software, please click lvére (Latest version 2.6.14)

Important - Please DO NOT instalf our software on your Doclfan or Contract+
Server

During the installation you will need to telephone Oberoi on 01332 224251 to obtain a
registration code.

If you want to use Oberoi on more than one PC, then we would recommend select the option
for a Virtual Server configuration when you are prompted during installation. This results in
only one instance of Oberoi, but it is accessible from any PC in the practice.

If you are not sure whether Oberoi is installed, or how it is configured at your practice, or if you
wish to discuss Oberoi configuration options or would like Health Informatics to oversee its
installation and configuration at your practice, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).



http://www.oberoi-consulting.com/primaryprevention.aspx
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2. Accessing the Software

Locate the Oberoi Clinical Observations icon on your

and double click on it:

desktop

A window will appear (as shown below), asking you for a username/password:

Username: oco

Password: prevention CIi ni I

Pazzward:

user

Please login:

®

oberoi

ions

|Jzer name: ||

Login |

2.9

3. Configure Risk Factors in Oberoi

Pressing the F3 function key in Oberoi allows
configuration of risk factors by which patient’s
scores will modified on account of their
ethnicity or the presence of a family history of
There is a field to enter the risk factor for family
history adjustment. Ethnicity risk factors can be
by selecting the appropriate line, clicking the
button and typing a new risk factor.

Previous versions of Oberoi (2.6.14 and earlier)
a MULTIPLICATIVE approach to compute risk
scores for patients who have both a family

B

Risk Factor Adjustments "'

Tate *

Carest

the
risk

CVD.

set
‘Edit’

used

history risk factor and an ethnicity risk factor — i.e a patient with both risk factors would have their risk

multiplied by 1.4 x 1.5 = 2.1.

Some recent guidance would suggest this would lead to an overestimation of risk.

Later versions of Oberoi (2.6.15 and later) now provide the option to choose the method of handling the

calculation of multiple risk factors. You can select either:

i) Single Highest - i.e. if patient has both FH risk factor 1.5 and Ethnicity risk factor 1.4, only 1.4 would be
used — this method might lead to underestimation of risk (default setting on Oberoi)

ii Additive - risk factors are individually reduced by 1.0, added together and

then added backto 1.0-i.e (1.4-1.0) + (1.5-1.0) +1.0 = 1.9.

iii) Multiplication - not recommended as might lead to overestimation of risk

To avoid any confusion and incase any practice might be using older versions of Oberoi,



we are currently recommending that only the Family History risk factor should be configured.

Therefore Risk factors should be configured as follows:
a. Arisk factor of 1.5 should be set for the family history adjustment

b. The default risk factor of 1.0 should be maintained for all ethnicity codes

4. Run Oberoi Extraction and Analysis

Once risk scores have been configured in Oberoi, you are ready to run the data
extraction/analysis. To do this, click the ‘Analyse clinical data’ icon on the Oberoi toolbar (the
cog symbol).

{} Oberoi Clinical Observations ¥2.5.23 (EMIS L¥) - 1BS Risk Ana

File Actions Patient Mail Merge Help

Bk

Risk Analysis (All undiagnosed patients 32-74) -

You’'ll be prompted to agree to the User License Agreement and then you’ll need to click the
‘Analyse’ button to commence extraction.

If the analyse function fails to be able to extract data, it might be because Oberoi is set up for
the wrong clinical system (i.e. EMIS/Vision). The clinical system setting is shown on the top bar
of the window (see screenshot above). To select your correct system, select the File / System
Options menu entry and then select your clinical system fro the list.

5. Export Oberoi extraction to Excel

You’ll be presented with the main data screen in Oberoi, which will show extracted patient
data. This screen defaults to the ‘F5 Undiagnosed’ view — i.e. patients without an existing
coronary or atherosclerotic diagnosis. You can toggle between a variety of views using the F5,
F6, F7 and F8 function keys. Before exporting data, ensure that the view you are using is either
F5 View Undiagnosed or F8 View All. To export the data from Oberoi to Excel, press F11 Excel.
You may receive an error message, but no data will have been lost.

6. Apply filters
It is necessary to apply some filters to the data in

. . . . . 5 Yawdos b
Excel in order to identify patients suitable for ,‘,'T'Ix - T
inclusion on the CVD at risk register. To apply filters to T . e L
the data in Excel, go to the Excel menu option Data | = .. abaralrbr..

» Filter » AutoFilter



You’ll see drop-down boxes appear at the top of each

of the columns in Excel. These can be used to filter the 51'3:3”"'S-J;?°"‘m‘i-7-'5:“m“°'4'-v°"""‘?"“"
Mo Yez Mo JBS cardizas:

data‘ My Yes Ny J35 cordimase
Mo ez My JBS crdigvast
i Ve M

To obtain a list of patients appropriate for inclusion on the CVD at risk register, apply the

following filters:

a.

On the Diagnosed? column apply the filter ‘No’ — this will remove patients who already
have a diagnosis of CHD.

On the Diabetes? Column apply the filter ‘No’ — this will remove the patients who
already have a diagnosis of diabetes

On the CVD column apply a custom filter to select patients with a 10-year CVD risk >

0,
20%
E Show rovws whers
| e
| & greater than w | 2 -
|
\ =& &
| - -
l Use 7 bo regrosent ay Snghe (Nracter
| s * 1o eopmesant any seoms of characters
‘ % | | cae |

After applying your filters, select the whole worksheet and copy and paste it into a new

worksheet. These are the patients who, subject to clinical judgement, are appropriate for

inclusion on the CVD at risk register.

7. Review Risk Scores

Note that the addition to a patient’s medical record of a CVD risk score is a clinical decision and

a clinician should be responsible and accountable for approving a list of risk scores before they

get added to patients’ medical records. How this process is performed is down to local choice,

but you may wish to consider the following:

a.

Do any of the risk scores look unusual or inappropriate? If so, investigate them before
coding them. An example might be a risk score that has been skewed by erroneous
data in a patient’s medical record? (e.g. a BP incorrectly recorded as 880/90 resulting
in a CVD risk of 97%.)

Are there any patients identified for inclusion on the CVD at risk register who actually
have diabetes or CHD but who are missing this as a diagnosis in their records? If so,
they needn’t have their CVD risk score coded — instead they should have their
diagnosis recorded. An example might be a patient with a readcode for the procedure
of a Coronary Artery Bypass Graft but without a readcode for IHD.

Are there any patients who, in your clinical judgement, would be inappropriate to be
managed as a CVD at risk patient under the QOF+ CVD primary prevention indicators?
For example, a patient in the advanced stages of terminal cancer might be offended if
they received an invitation to attend the surgery for screening of their 10 year CVD
risk. Such patients needn’t have their CVD risk score coded which will ensure they do
not enter the CVD at-risk register.



d. As a clinician, do you want to review each patient’s medical record before deciding
whether to code the patient’s risk score or merely take a high level overview of the
scores before approving them for coding?

You will now have identified a list of patients in the following two groups:

c. Patients with a 10-year CVD risk score in the range >20% - 30% (Read Code: 662m.)

d. Patients with a 10-year CVD risk score in the range >30% (Read Code: 662n.)

These patients will make up your CVD at risk register and will need to have their risk score Read
coded.

You may wish to add the codes manually, in order to enable you to briefly review each record before
adding the code. Alternatively, you may wish to use bulk code entry (Vision) or batch processing
(EMIS) as described later in this document.



1.2 Updating your CVD at risk register
Intermittently, you will wish to update your CVD at risk register in order to identify patients who:
a. Have recently registered with the practice and are at high risk
b. Were not previously at high risk, but whose risk has recently increased

To do this you will need to re-run Oberoi using the ‘Analyse clinical data’ icon on the Oberoi
toolbar (the cog symbol).

{} Oberoi Clinical Observations ¥2.5.23 (EMIS LY} - JBS Risk Ana

File Actions Patient  Mail Merge  Help

|| @ B

Risk Analysis (All undiagnosed patients 32-74) -

When you export the data to Excel and apply the filters to remove patients with CHD, patients with
diabetes and patients with risk scores <= 20%, you will need to apply a further filter on the column On
Register in order to display just ‘Blanks’ — this will remove patients that are already on your register,
leaving only patients who:

a. Don’t have CHD,
b. Don’t have diabetes,
c. Have a CVD risk >20%,

d. Are not already on your CVD at risk register

P 2
stirate{ = |On Register -3
Sort Ascending
Sotk Descending

(Al
(Top 10...)
(Custom,..)

o

o

JBS cardiovascular disease visk »>20% up ko 30% ov next 10 v on 20 Jan 2009
JBS cardiovascular disease risk >20% up to 30% ov next 10 vr on 9 Jan 2009
JBS cardiovascular disease visk »30% over next 10 vears on 20 Jan 2009

JBS cardiovascular disease risk >30% over next 10 vears on 9 Jan 2009

JBS cardiovascular disease rvisk 10-20% over next 10 years on 12 Jan 2009

JB5 cardiovascular disease risk 10-20% over next 10 years on @ Jan 2009
{MonBlanks)

These patients will then need their risk scores coded.

[

[

WL LWL WL L [
w

w

If you require training using Oberoi or are having problems following the process above, then please log
a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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Section 2:

QOF+ processes for CVD primary prevention
with INPS Vision



2.1

Creating your CVD at risk register

In the previous section, you will have identified using Oberoi a list of patients in each of the following two

groups:

a. Patients with a 10-year CVD risk score in the range >20% - 30% (Read Code: 662m.)

b. Patients with a 10-year CVD risk score in the range >30%

(Read Code: 662n.)

These patients need their risk scores Read coded in order to establish your CVD at risk register.

You may wish to create your CVD at risk register manually by individually coding each patient within

Consultation Manager. This will enable you to briefly review each record before adding the risk code.

Alternatively, for each of the two groups listed above you can follow the instructions below to set them

up as a Patient Group in Vision which will enable you to bulk add the appropriate Read code to the

Group. You will need to create the Patient Group as the output of a search filtered on NHS number:

a.

Open the Reporting » Search and Reports module of Vision

b. Click the L4 New Ad-hoc Search button to open the SEARCH: New Search window

C.

Click on the Patient Details entity and click on Selections

Click on Current NHS Number

Click on Add New and type in the first patient’s
NHS number. Keep clicking Add New and typing
in the each patient’s NHS number until all of the
NHS numbers in your group have been added.

NOTE: Be sure not to combine the two groups
given above — you'll need a separate Group for
patients with risks >20-30% and risks >30%. And
pay careful attention that you are entering the
numbers correctly.
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the SEARCH: New search screen

|| Report Output = -

— 1 w0

Report Betads

Double-click in the Group Output section:

Give your Group an appropriate Name and a

Description and click OK:
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n.

Click Run. The search will run and the output will go to a Patient Group.

Switch to the Reporting » Patient Groups module of Vision

Find the Group you created above, select it and go to the menu option Group Applications »

Generate History

You will get a History — Add screen for entering the

Read term.

Double-click in the ‘Read Term for Characteristic’ field

to launch the Read dictionary and

appropriate Read Term (662m. or 662n.). Fill out the
remaining options. We would suggest the following:

i. Event Date: Should be the date you ran the

Oberoi extraction

locate the

History - Add ﬁ'

Evart Do i I~ Pzeto

04 Nssch 2000 M1 Ped Informatics | n Practes
Fieat Tomn bot Chascsends

£E2n 00 JBS caedireaaCully thiede ok > 20K up %0 30T ov e

Corvaard

[Cakdied ty Obercd Chrac Otacvaties Sule

Tyoe of Chasactengtc Eowode Type Py o ;
Dagrarss . Contrarg vl [1 |

g Corcl |
Endlae o

ii. Comment: “Estimated by Oberoi Clinical Observations Suite”

iii. Type of Characteristic: Diagnosis
iv. Episode Type: Continuing
v. Priority: 1

vi. End Date: Leave Blank

Click OK. The Read codes will be added to the patients’ records.

Note: You will need to complete the above steps for both of the patient groups (>20%-30% and
>30%).

Once this is done, your CVD at risk register will be in place.

If you require assistance in creating the CVD at risk register or are having problems following the

process above, then please log a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020

8383 8655).
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Creating a single CVD at risk Patient Group

The Patient Groups that you set up in the previous step were purely to enable the bulk addition of the CVD
risk codes to patient records based on the NHS numbers extracted by Oberoi. Once this has been done, the
two Patient Groups can be deleted and replaced with a single Patient Group based upon the standard
definition of the CVD at risk register. To do this, complete the following steps:

a. Open the Reporting » Patient Groups module of Vision, find the two groups you defined above and
delete them

b. Switch to the Reporting » Search and Reports module of Vision and click the L4 New Ad-hoc
search button to open the SEARCH: New Search window.

c. Add the following Selection to the Patient pepsp—" Bi%l

Details entity: Date of Birth in the Range T-75y | s |
to T-32y (i.e. people aged 32-74) Do | o | Ced| b

g nth place »
@ CHI Husdier

Please ignore the screenshot which [ o

-‘C.qddnn Suppleeos)
shows T-74y — the correct selection B s larlrg
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the following selections on it: Ao o | Coeed | te
= A chwr Orsced Dan
A ) . . . AN athar Clinicad Daln - Rl boede
i. Read Code C10.., hierarchical (i.e. Diabetes) Autherize
Clnwan . Eee Bod Bl
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Epavde lype e -
In peacte
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ii. Read Code G3..., hierarchical (i.e. CHD)

¥ Huacty et Soreryen

e. When you return to the SEARCH: New Search
screen, right-click the All Other Clinical Data

Heat deccipinn
Tunn 1 meckeal aniye

o =] o

entity and select Options.

Trad. do o Exiduls

f.  Change the Option from Include to Exclude and un-tick the box

Sl s e Taen arared Azsnt Ine &ty
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g. Add a second All Other Clinical Data entity and click ‘yes’ at the prompt ‘All other Clinical Data has
already been selected, do you want to select it again for cross entity search?’

h. Add the following selections onto the second All Other Clinical Data entity:
i. Read Code 662m. (i.e. CVD Risk >20 — 30%)

ii. Read Code 662n. (i.e. CVD Risk >30%)



i.  Ensure that the ‘Match All’ option is selected in your search screen

j. Your final search should look like this:

& SEARCH: New Search

File Edit Maintenance Help

Search Input o Report Qutput|vise ~|
Group Input: Eleel Group Output:

| |

Search Details Selections | Add Entity | Report Details #dd Entity
Search Details

eport Details |

Qﬁi Patient Details Patient Details [all]
LDate of Birth All ather Clinical D ata (&)
I-|-Is Between T-7dp [INC] And T-32y [INE]l All ather Clinical Data #2 [Matches)
lE All other Clinical Data [Exclude] |
LRead code

0F Type C10..00 Diabetes melliuz
OF Type G3...00 Izchaemic heart dizease
L0 4l ather Clinical Data #2
Read code

0F Type BBZ2m. 00 JBS cardiovascular disease risk »20% up to 30%
OF Type B62n.00 JBS cardiovascular disease rizk »30% over nest

< I >

Match on all or any

Do pou wish to include patients if a | | ‘
match is found on any entity, ar only i £ Match Any Bun New

matches are found on all zelected % Match &l | | ‘
entities. Cloze Help Save bz

Some of the important features of the search have been highlighted in red on the screen-shot.

k. Double-click on the ‘Group Output’ section, _

Group Narme Group Descnphion
give your Group an appropriate Name (e.g |[ooa= [EVD A1 Fisk Rugater [DV0 104 R > 0%
.. . [$MDAN Anabs OF P Wih Aroc & Dep inG@1
CVD ARR) and Description and click OK QEXCCUN sl Dala E sthord Fiom Magorat Qs 2

Inentirdzabions Dada € sciuded From Miguedt Qusims
Data Exchaded From Mgues! Queres
SMONALTVE Patwert Spatern Group: Miguet Inactve Patntz
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IMDRSTO0M  Repat O chong & Brei In Pas 16+

IMODRPTO00S Aelenat Repon (Praudorgmrized|

IMORPT 000 Aelenal Report [Psaudongmriad|

IMORFT0007 Patients With incorect Gender Codes Audt (Pseado

| $MORPT 0008 Pahents 'With incoract Gendar Codes Audt (Preudo .

[ ] cwew | w6 |

I.  Click Run. The search will run and the output will be saved to a Patient Group.

m. Save your search with an appropriate Title since you may need to re-run it in the future to
update the Patient Group

If you require training on using the Search and Reports module in Vision or need any assistance with the

above process then please log a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383
8655).
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2.3

Adding a button to your Primary Prevention of CVD Guideline to aid call and

recall

You may find it useful to add a button as described below to your CVD Primary Prevention Guideline.
The button will be used to enter the following Read code into the patient’s record:

6C2.. Primary prevention of cardiovascular disease

This Read code will act as a flag to indicate that the patient has attended a Primary Prevention of CVD
appointment. This will help you search for patients on your CVD at risk register who have not attended

for a CVD appointment (i.e. who do not have this Read code).

1. In Consultation Manager, go to the menu option Guidelines » Select Guideline

2. Type the mnemonic QPCVDRISK, press return and click View. Your QOF+ CVD Primary

Prevention Guideline will load:

Coesulatinn Waseges - [Q0F - - Y1 Brinary Preversios Quaisy . [ 1191158
G-Jrnlv..n By @eces N UE e Wndie e =
(= 50
FO DI DK B n te
QOF+ : CVD Pamary Pravention Quadty Indicators -

CVD Risk Scare

0P % | CHD Mrmars P Gy Dbty

3. Press the ,ﬁ Maintain button to switch the Guideline into edit mode.

The edit toolbox will appear.

4. Click on the very top row of the Guideline and then click the

0OF+ : C¥D Primary Pre...@
aEEEE

@ H M=

-
—

Clinical Data Hotspot button on the toolbox. This will enable you to define the properties of the

button that you are adding to the Guideline

5. A Clinical Data Hotspot — Add box will appear. Complete it with
the following details:

a. Caption: “Patient attended CVD Primary Prevention
Appointment”

b. Default Read Term: Double-click in this field to launch
the Read Dictionary and navigate to the 6C2..00
Primary prevention of cardiovascular disease

Read code.

c. In the Vision Database Hierarchy, navigate to the
Medical History area.

d. Click OK

6. Pressthe ,ﬁ Maintain button to take the Guideline out of edit
mode.

o+ Add " Dizplay " Edit

lzon. . .
Caption Command Button [v

|F'atient attended CWD Primary Prevention Appointme

Default Read Tem

|EE2..DD Frimany prevention of cardiovascular dizeas

f* Single Data Entry Form " Multiple Farms

Recalls and Reviews ~
Referal: and Requests
=4l ather Clinical Data

B &l cther Clinical D ata

B Patient Preference

Dirug Allergies & Adverze Reactions

=tdedical and Family History

| |Medical Histary
B Family History

B “bsence of condition

1 ik

ak | Cancel |

Clinical Data Hotspot - Add 3

7. Your Guideline should appear as follows, with a button that can be pressed when the patient

attends for a CVD Primary Prevention appointment:




BY QOF+ : CVD Primary Prevention Quality Indicators

B =D D i 2 F
QOF+ : CVD Primary Prevention Quality Indicators S

|| Patient attended CYD Primary Prevention Appointment |i

CVD Risk Score
Family History
Lifestyle
Examination
Investigation
Prescribing

If your QOF+ Guidelines have not been installed, or if you encountered problems installing them or

configuring them or if you require any assistance in making the modification outlined above, then please
log a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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2.4 Setting up your CVD primary prevention invite letters

In order to perform a mail merge in Vision, you will need to configure your CVD primary prevention
invite letters. To do this, complete the following steps:

a. Go to the Utilities module of Vision and open the Word Processor

b. You’'ll be prompted to specify the type of Template that you are creating. Choose ‘Patient’ and
click Create Template.

c. Microsoft Word will launch with a mail merge toolbar:

Documant! - Crasle Patsent Template

Dw O Pww Dwet Pgmeat Joch Tdse  Wedow el

Adid i3 0 oz 242 ARG 0 " e - | uuese B
i ems oz teesweiown 202 o B2 N [Elm M iss S DAY
G L L T et word ek - | - M4 r oM Lo 2y l
‘:IT DRI, - ¢ - f ¢ Bt f B b Al S )Tk BB
Insert Merge Field [g|
d. Write your CVD Invite letter, using the = Insert Merge Fields icon | msert:
. (O address Fields (%) Database Fields
to enter merge fields. There are sample letters on the follow pages | g

. . . . PRACTICE_Blockadd
with electronic versions available from: PRACTICE M, Comm Ho 2
PATIEMNT _Title

PATIENT _Faorenarnel
http://www.qgofplus.co.uk/more PATIENT Forenanez
PATIEMNT _Sex
PATIEMT Date_of_Birth
PATIEMT_Current_NHS_Mumnber
PATIEMT _Mew_Farmat_MHS_Mumber B
. . . PATIENT_Cld_F E_MHS_Murmbs
a. When you're happy with your letter, save it in the | ramentcrinomer

X . . . PATIENT_Registered_GP
TEMPLATES folder (this will be the default location) with | |PATIENT Req_GP_GMP_code

PATIENT Req_GP_PPA_cods v
an appropriate name. [MatchFieIds... ] [ Insert

l[ Cancel ]

b. You will need to follow the same steps for any other merge letters you wish to send
out, such as 2"%/3% invite.

If you would like training on setting up merge letters/forms in Vision, or if you encounter problems or

require assistance setting up your merge letters, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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VISION Sample Letter 1

Inviting patient to attend for health check without prior fasting blood tests

«PATIENT _Title» «<PATIENT_Forenamel» «PATIENT_Surname»
«PATIENT_House» «PATIENT_Road»

«PATIENT_Town»

«PATIENT_County» «PATIENT_Postcode»

Date : «SYSTEM_Date»

Dear «PATIENT_Title» «PATIENT_Forenamel» «PATIENT_Surname»

Invitation for a Health Check

We would like to invite you to attend the practice for a NHS Health Check to see if we are able to
help you reduce the risk of developing heart disease or having a stroke in the future. This health

check may last up to 20minutes and will include checking your weight and blood pressure.

Please could you contact our reception staff to arrange an appointment for your Health Check.
Please mention that you require a “Health Check” to ensure you are given the correct appointment.

If you have already responded to a previous letter inviting you to attend for a Health Check, please
accept our apologies for sending you this further letter.

Many thanks for your co-operation

Yours sincerely



VISION Sample Letter 2
Inviting patient to attend for health check with prior fasting blood tests

«PATIENT _Title» «PATIENT_Forenamel» «PATIENT_Surname»
«PATIENT_House» «PATIENT_Road»

«PATIENT_Town»

«PATIENT_County» «PATIENT_Postcode» «SYSTEM_Date»

Dear «PATIENT_Title» «PATIENT_Forenamel» «PATIENT_Surname»
Invitation for a NHS Health Check

We are inviting you to attend the practice for a NHS Health Check to see if we can help you reduce the risk
of developing heart disease, diabetes or having a stroke in the future. This health check will include checking
your weight and blood pressure. Please could you contact our reception staff to arrange an appointment for
a “NHS Health Check”

We would like you to have some blood tests done at least one week before you attend your health check
appointment. You can have your blood test done by attending one of the following services:

1) Pathology Department at Charing Cross Hospital, St Dunstan’s Road W6 8RF
- Walk-in Service: Mon-Fri 08:30 till 16:00 (No appointment needed)

2) Parsons Green Health Centre, 5-7 Parsons Green, SW6 4UL
- By Appointment: Mon-Thu 08:00 till 09:45 or Fri 08:30 till 12:30
You need to make an appointment by calling 020 8846 6767.

You will need to fast before the blood tests. This means that you cannot eat or drink anything (apart from
water) for 12 hours before your blood test. You should continue to take any regular medication that you are
on. Please take the enclosed blood test form when you attend for your blood test. We should be able to
discuss the results of your blood tests when you attend for your health check appointment at the surgery.

If you have already responded to a previous letter inviting you to attend for a Health Check, please accept
our apologies for sending you this further letter. If you wish to decline this invitation for a Health Check,
please complete and return the slip at the bottom to avoid us sending you further reminders.

Many thanks for your co-operation

Yours sincerely

I would like to decline this invitation for a NHS Health Check because:
Signed: Date:

Name: «PATIENT_Title» «PATIENT_Forenamel» «PATIENT_Surname»
NHS Number: «PATIENT_Current_ NHS_Number»



VISION Sample Letter 3

Patients whose health check is satisfactory

«PATIENT _Title» «<PATIENT_Forenamel» «PATIENT_Surname»
«PATIENT_House» «PATIENT_Road»

«PATIENT_Town»

«PATIENT_County» «PATIENT_Postcode»

Date : «SYSTEM_Date»

Dear «PATIENT_Title» «PATIENT_Forenamel» «PATIENT_Surname»

Your recent health check

You recently attended the practice for a health check. We are pleased to inform you that your tests
results are satisfactory. Therefore you do not need to take any further action at this time but we
would advice you to have a further health check in 5 years times.

Many thanks for your co-operation

Yours sincerely



VISION Sample Letter 4

Patients whose health check is not satisfactory

«PATIENT _Title» «PATIENT_Forenamel» «PATIENT_Surname»
«PATIENT_House» «PATIENT_Road»

«PATIENT_Town»

«PATIENT_County» «PATIENT_Postcode»

Date : «SYSTEM_Date»

Dear «PATIENT_Title» «PATIENT_Forenamel» «PATIENT_Surname»

Your recent health check

You recently attended the practice for a health check. | would like to invite you back to the practice
to talk about your test results and discuss future care.

Could you please contact the practice and make a routine appointment for review?

Many thanks for your co-operation

Yours sincerely



2.5

Adding Reminders to the records of patients on the CVD at risk register

You can add reminders to the records of patients in the CVD ARR Group so that when their records are

opened during consultation, the GP is alerted to the fact that the patient is on the CVD at risk register

and therefore needs the QOF+ CVD primary prevention metrics completed. To do this, complete the

following steps:

a. Open the Reporting » Patient Groups module of Vision

b. Find and select the CVD ARR Group and go to the

menu option Group Applications » Reminder...
c. You will get the following dialog box:

Leave the options set to default (fixed reminder)
and type a suitable reminder prompt (e.g. “On
QOF+ CVD at risk register — complete metrics”)

d. Click OK

Your reminders have now been set up.

Group Reminder CVD ARR Cvd At Risk Register (Cvd 10... 5]

(o Add o segle Aeod mnndet (o o palosts 1 the cloup
Jby v sesvwndon of 1 o vy e added
Sid s erinder ndvidaely o sach petier: i the croup, Thess

J . . "L - -
serricets may be subsequenty sdisc o 2n indimcus shen: baci,

O Banceen e dens hom thes gou
Ramince Tak:
E”" A0F+ VD o e g - avpmba medicy v

o | Cawel

When the patient’s record is viewed, the reminder appears in their reminder list:

‘hera
—— Joe TESTPATIENT 59Y [M]

. 1. ] On QOF+ WD at sk register - complete
anE 3 retrics

When the GP has completed the QOF+ Primary Prevention metrics, the reminder can be

‘crossed-off’ by double-clicking on it:

“hera

—— Joe TESTPATIENT 59Y [M]
1. [ D O0F-CVD ot .

ans 3 Fskres

If you encounter any problems with this process, then please log a call with the IT Service Desk

(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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Generating Invite Letters

The following steps describe how to merge the invite letter that you defined in Section 2.4 to Patient
Group CVD ARR.

a. Open the Reporting » Patient Groups module of Vision and find the CVD ARR Group

b. Go to the menu option Group Applications » Generate

Recalls Group Recalls 3

c.  You will receive the following prompt > RaECeap
CRDARR Pl Wik 110 s Cod Rigk 32005

d. Under the section ‘Personalised Letters’ click the button A Rl 16 Modbact History

‘Create’ Recdl secordt vl ot el be
added 20 polords’ ceacy feston

e. At the ‘Document Merge’ screen, click ‘Browse’ and find

the template letter that you defined in Section 2.4 above Personslsed Leter:
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If you need any help performing the merge described above, or if you encounter problems or require
assistance with the process, then please log a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk ,
020 8383 8655).
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2.7 Documenting the dispatch of invite letters in patients’ medical records

The steps below describe how to add the following Read code to patients’ records to document that a
CVD Primary Prevention invite letter has been sent out:

90x1. At high risk of cardiovascular disease monitoring letter invite

a. Go tothe Reporting » Patient Groups module of Vision

b. Find the Group CVD ARR, select it and go to the menu option Group Applications » Generate
History

c.  You will get a History — Add screen for entering the term.

d. Enter the Read Term 90x1. and fill out the remaining options. We would suggest the following:

i
ii.
jii.
iv.
V.

Vi.

Event Date: Date the letters were generated
Comment: Include the body of the invite letter
Type of Characteristic: Administration

Episode Type: <None>

Priotity: 9

End Date: Leave Blank

e. Click OK. The Read codes will be added to the patients’ records.

This will enable you to easily run a search to identify patients who have received an invite letter within a
particular period.

Make a note of the date that you assigned to the Read code; this may help later when identifying
patients who need a second invite letter

If you encounter problems or require assistance with the process, then please log a call with the IT
Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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2.8

Data entry during your CVD primary prevention appointments

Practices have been provided with Guidelines specially designed for recording the information required
by QOF+. They follow a similar format to the QOF Guidelines that you’re familiar with, so should be
intuitive to use.

Below is a screenshot of the CVD Primary Prevention Guideline with some of the sections expanded:

B QOF + : CYD Primary Prevention Quality Indicators =laxl
BW| =D @6 E Y EH B 2 F
QOF+ : CVD Primary Prevention Quality Indicators =

CVD Risk Score
Family History
Lifestyle

Reminder: Rows in the table will be hidden if there is no data in them - click on the top-left cell to see all available rows

01014961 | 21071995 | 02042001 | 0341242008 | 03412/2008| 034122008 +
Sroking 4 4 4 4
Alcohal b4 b4

Exercise...
Diet...
Smoking...
Alcohol...

Examination
Investigation
Prescribing

Active Repeat Masters - Lipid-regulating drugs:
Repeat Masters - Ho relevant data available.

Other recorded statin information:
Last 10 All other Clinical Data Records Where READ_CODE = "8B3z" OR READ_CODE = "813C™ OR READ_CODE = "8163" OR READ_CODE = "8B6A™ OR
READ_CODE = "$IT¢" OR READ_CODE = "8127" OR READ_CODE = "TJC2400™ OR READ_CODE = "TJC2500" OR READ _CODE = "UG0CAM0" - Ho relevant data
available.

Click here to prescribe statins...

Click here to prescribe other lipid-regulating drugs...

0 tatin Therap | Statins not indicated I| Statins offered, but declined I

If your QOF+ Guidelines have not been installed, or if you encountered problems installing them or
configuring them or if you require training on using Guidelines in Vision, then please log a call with the
IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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2.9

Recording that patients have declined the invite

If patients explicitly decline the invitation for a CVD primary prevention appointment, they may be
excepted using the following Read code:

8IAC. Vascular disease risk assessment declined

Note that a patient cannot be inferred to have declined on the basis of only one invite letter. Evidence
of three invite letters/attempted contact will be sought where a patient has been excepted using the

above code.



2.10 Identifying patients who need a second/third invite letter

You will need to follow up your initial invite letter with a second/third invite letter for those patients

that have neither attended for an appointment nor explicitly declined the invitation.

You can run a search for these patients and assign them to a new Patient Group. Then you can follow

the same process defined above to generate a second invite letter for them and document that this has

been sent to them.

The following instructions describe how to create a Patient Group of patients who:

a. Areonthe CVD at risk register

b. Have received a CVD Primary Prevention invite letter, documented using the Read code 90x1.
At high risk of cardiovascular disease monitoring letter invite

¢. Have not had a CVD primary prevention appointment recorded using the Read code 6C2. .
Primary prevention of cardiovascular disease

d. Have not been excepted using the Read code

8IAC. Vascular disease risk assessment declined

These patients will need to be re-invited

1. Go to the Reporting » Search and Reports module of Vision and click the o New Ad-hoc search

button to open the SEARCH: New Search window.

2. Double-click in the Group Input field and choose the Group CVD ARR.

3. Add the All Other Clinical Data entity and define a Read
Code 6C2..
cardiovascular disease and 8IAC. Vascular disease risk

selection of Primary prevention of

assessment declined and a date selection of ‘After
30/06/08’. Right-click this entity, select options and switch
it from ‘include’ to ‘exclude’. Un-tick the box ‘Exclude
patients with no records for this entity’

All other Clinical Data

Include or Exclude

Ciiteria haz been entered againzt this entity.
Do pou wizh to include ar exclude patients matching the criteria.

™ Include

* Excluds

™ Erclude pahents with no records for thiz entibe

o]

Cancel | Help |
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4. Add a second All Other Clinical Data entity and define a Read code selection of 90x1. At high risk of
cardiovascular disease monitoring letter invite and a date selection of ‘After 30/06/08".

5. Ensure that the Match All option is selected on your search screen.

6. Double-click in the Group Output field and give your

search an appropriate name:
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7. Your search should now look as follows:

& SEARCH: New Search

File Edit Maintenance Help

Search Input

= | I Select ‘
FperprHeE

|CWD ARR Ptz With 10°ear Cvd Risk »20 %

Report Qutput|view |

Group Output:
|C\r‘D.t’-‘n.Fl INW2 Patients requiring a 2nd CVD at risk invite

.dd Entity I ity
Add Ent Report Details Add E

eport Details |
Fatient Details (&)
All ather Clinical D ata [Al)
All ather Clinical Data #2 [Matches)

Search Details

Search Details
Patient Details
Al other Clinical D ata (Exclude) |
D ate of event
Uiz After 30 Jun 2008 [INC)
LRead code
Of Type BCZ..00 Primary prevention of cardiovazcular dizease
Of Type BIAC.00 Vascular disease risk aszessment declined
All otker Clinical Data #2
Date of event
Lis After 30 Jun 2008 [INC)
LRead code

Log Type S0x1.00 At high rigk cardiovazcular disease monitoring let

b

*

Match on all or any
Do you wish to include patients if a R ‘
match is found on any entity, or only i £ Match Any e
matches are found on all selected (% Match &l ‘ ‘ ‘
entities, Cloze Help Savebs

Some of the important features of the search have been highlighted in red on the screen-shot.

You now have a Patient Group of patients that require a second invite letter. You can follow the same

process as in Section 2.6 and 2.7 to generate a second invite letter for them and document that this has
been sent to them.

If you encounter any problems with this process, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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2.11 Targeting your approach

The procedures above describe how to target your entire CVD at risk register in one go using a single
Patient Group. You may, however, wish to employ a more targeted approach by breaking the register
into a number of sub-groups who you will target in turn. The processes described in this document can
easily be adapted to be applied to defined subgroups of your CVD at risk register.

You would need to define searches to identify each separate sub-group of patients that you wish to
target.

A few possible approaches are as follows:

I. Target all patients on the CVD at risk register right away to maximise your chances of
getting to see everybody before the end of the QOF+ period (this is the process described
in this document).

II. Only target patients on the CVD at risk register who don’t have hypertension. Modify
your processes for dealing with hypertensive patients in order that the QOF+ CVD
primary prevention indicators for any hypertensive patients on the CVD at risk register
are performed as part of your normal process for managing hypertensive patients. This
will help prevent duplication of time/work for patients who are already getting recalled
as part of your hypertension call and recall procedures

lll. Break your CVD at risk register down into subsets in order to spread out the work load
over the QOF+ period. This might help manage capacity within the practice. One
approach could be to target the higher risk (>30%) patients first and then the
intermediate risk (>20-30%) patients

IV. An alternative approach to the one above could be to target the higher risk (>30%) males
first, then higher risk females, then intermediate risk (>20-30%) males and finally
intermediate risk females

Below are some screenshots of searches that enable you to break the Patient Group CVD ARR into
subgroups:

Patients on the CVD at risk register without hypertension:

@ SEARCH: New Search
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I
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Higher-risk (>30%) patients on the CVD at risk register:
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2.12 ldentifying patients who have had a CVD Primary Prevention appointment,
but failed to return for fasting blood tests

You may have patients on the CVD at risk register who have attended for a CVD primary prevention

appointment and have had most of the QOF+ CVD primary prevention indicators completed, but who

were asked to return having fasted to have their blood tests performed and who have failed to do so.

The following instructions would enable you to find patients who:

a.

b.

C.

Are on the CVD at risk register

Have had a CVD primary prevention appointment recorded using the Read code
6C2.. Primary prevention of cardiovascular disease

Have not had any cholesterol or FBG blood test results recorded

Instructions:

Go to the Reporting » Search and Reports module of Vision and click the o New Ad-hoc
search button to open the SEARCH: New Search window.

Double-click in the Group Input field and choose the Group CVD ARR.

Add the All Other Clinical Data entity and define a Read Code selection of 6C2.. Primary
prevention of cardiovascular disease and a date selection of ‘After 30/06/08’.

Add the Test Results — All entity and place a Read code selection on it for the following Read
codes (these are the blood test codes that qualify for QOF+) and a date selection of ‘After
30/06/08’:

440E. Plasma total cholesterol level

44P1. Serum cholesterol normal

44P2. Serum cholesterol borderline

44P3. Serum cholesterol raised

44P4. Serum cholesterol very high

44P). Serum total cholesterol level

44PH. Total Cholesterol Measurement
44T2. Fasting blood sugar

44g1. Plasma fasting glucose level

44f1. Serum fasting glucose level

44dA. Plasma HDL cholesterol level

44d3. Plasma fasting HDL cholesterol level
44d2. Plasma random HDL cholesterol level
44P5. Serum HDL cholesterol level

44PB. Serum fasting HDL cholesterol level
44PC. Serum random HDL cholesterol level

Right-click the Test Results —All entity, select options and switch it from ‘include’ to ‘exclude’.
Un-tick the box ‘Exclude patients with no records for this entity’

Ensure that the Match All option is selected on your search screen.
Double-click in the Group Output field and give your search an appropriate name.

Your search should now look as follows:
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Some of the important features of the search have been highlighted in red on the screen-shot.

If you require training on the Search and Reports module of Vision, or if you require any assistance

defining searches for QOF+, then please log a call with the IT Service Desk (servicedesk@hf-
pct.nhs.uk , 020 8383 8655).
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Section 3:

QOF+ processes for CVD primary prevention
with EMIS LV



3.1 Creating your CVD at risk register

Once you have identified a list of patient IDs for patients in the following two groups, you can use the EMIS

batch processor to enter these codes onto patients’ records:

a. Patients with a 10-year CVD risk score in the range >20% - 30% (Read Code: 662m.)

b. Patients with a 10-year CVD risk score in the range >30% (Read Code: 662n.)

To use the EMIS batch processor, complete the following steps for each of the two cohorts above:

a.

b.

j.

Go to AO - Advanced Options » BD - Batch Processing
Click ‘Y’ at the warning prompt
Select option A — Batch Data Entry

When prompted to indicate how you’ll be defining the list of patients to apply the
batch processing to, choose option B - Generated Manually

Specify the Data Type as option A - Clinical Record

Identify the Read Code to be batch entered
Either: 662m. - Patients with a 10-year CVD risk score in the range >20% - 30%
Or: 662n. - Patients with a 10-year CVD risk score in the range >30%

Click ‘N’ when prompted whether to add the code as an active problem

When prompted to specify the date of entry, select option A — The same for all the
patients and accept the default date

At the confirmation prompt, check the details and press ‘Y’ to confirm (twice!)

Identify the patients one at a time by typing their patient identifiers and pressing return.

WARNING: Be very careful/thorough when entering patient identifiers for batch processing

k.

After identifying the final patient, press F1 to return to the previous screen.

Your CVD at risk register is now in place.

If you require assistance in creating the CVD at risk register, have any queries about the process

or are having problems following the process above, then please log a call with the IT Service
Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.2

Adding a code to your Primary Prevention of CVD template to aid call and
recall

To aid the call and recall processes, you are advised to add the following code as a ‘Yes/No’ prompt into
your Primary Prevention of CVD template:

6C2.. Primary prevention of cardiovascular disease
To do this, complete the following steps:

a. Go to DT - Dictionaries and Templates » C — Codes, templates, protocols » E — Edit
Access Screen/Forms/Templates » T - Templates

b. Navigate to the template titled Primary Prevention of CVD and select it.

c. Inthe Template Editor screen, select the option I — Insert Prompt and specify that you will
insert the prompt above prompt A

d. Select option A — Prompt for data to be entered into the medical record
e. Identify the Read Code 6C2..

f. Type a suitable prompt, e.g. ‘CVD Risk Assess’

g. Select option B - Yes/No prompt

h. Select ‘N’ for the remaining 3 prompts.

i. Press F1 to exit from the template editor

This prompt can then be used during consultation to record that the patient has attended a CVD
primary prevention appointment. Using the code in this way will help you identify patients that haven’t
had a CVD primary prevention appointment.

If your QOF+ templates have not been installed, or if you encountered problems installing them or
configuring them or if you require any assistance in making the modification outlined above, then please
log a call with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.3  Setting up your CVD primary prevention invite letters

In order to perform a mail merge in EMIS, you will need to configure your CVD primary prevention invite
letters. To do this, complete the following steps:

a. Goto WP - Word Processing » N — New Document

b. Microsoft Word will launch with a special EMIS toolbar: SoRRe Add e e L 3
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National P Code
st OF Kin

PIN

Past Medcabion
Compose your CVD primary prevention invite letter. Use the Mail Merge Variables R e

Pabisnt Address Lirm 7
button to insert merge variables into your letter, such as the Patient Address Block Paliont edcress Uow 2
field, the Title/Initial/Surname field and the Today... field (for the date). There are E?;'E;"
sample letters below and electronic versions of these samples available from: O .
Prvata NG
Anadode

http://www.qofplus.co.uk/more Sers b

Referal Number
Referral Reason
Aufwral Travoport Ragqured
Palfweral Lrgeocy
c. When you're ha with your letter, save it by going to the menu Sogmmadt,
* y ppy y ’ y g g Rogterad Doctor J
Qugpstration Sabus hA

File » Save As and then navigating to the folder MSWDocs on your

EMIS server (this is the location where EMIS stores letter and form
templates for merging using Microsoft Word). To find the MSWDocs folder when
saving the document, you may need to navigate to a path similar to the following:

My Network Places » Entire Network » Microsoft Windows
Network » Emis1234 » EMIS1234a » MSWDocs

d. You will need to follow the same steps for any other merge letters you wish to send
out, such as 2"%/3 invite

If you would like training on setting up merge letters/forms in EMIS, or if you encounter
problems or require assistance setting up your merge letters, then please log a call with the IT
Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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EMIS Sample Letter 1

Inviting patient to attend for health check without prior fasting blood tests

~[Title] ~[Calling Name] ~[Surname]
~[Patient Address Line 1]

~[Patient Address Line 2]

~[Patient Address Line 3]

~[Patient Address Line 4]

~[County]

~[Post Code]

Date : ~[Today...] Your Patient Number: ~[Patient Number]
Please quote this number
if booking an appointment

Dear ~[Title] ~[Surname]

Invitation for a Health Check

We would like to invite you to attend the practice for a NHS Health Check to see if we are able to

help you reduce the risk of developing heart disease or having a stroke in the future. This health

check may last up to 20minutes and will include checking your weight and blood pressure.

Please could you contact our reception staff to arrange an appointment for your Health Check.
Please mention that you require a “Health Check” to ensure you are given the correct appointment.

If you have already responded to a previous letter inviting you to attend for a Health Check, please

accept our apologies for sending you this further letter.

Many thanks for your co-operation

Yours sincerely



EMIS Sample Letter 2
Inviting patient to attend for health check with prior fasting blood tests

~[Title] ~[Forename] ~[Surname]

~[Patient Address Line 1]

~[Patient Address Line 2]

~[Patient Address Line 3]

~[Patient Address Line 4]

~[County]

~[Post Code] Date : ~[Today...]

Dear ~[Title] ~[Forename] ~[Surname]
Invitation for a NHS Health Check

We are inviting you to attend the practice for a NHS Health Check to see if we can help you reduce the risk
of developing heart disease, diabetes or having a stroke in the future. This health check will include checking
your weight and blood pressure. Please could you contact our reception staff to arrange an appointment for
a “NHS Health Check”

We would like you to have some blood tests done at least one week before you attend your health check
appointment. You can have your blood test done by attending one of the following services:

3) Pathology Department at Charing Cross Hospital, St Dunstan’s Road W6 8RF
- Walk-in Service: Mon-Fri 08:30 till 16:00 (No appointment needed)

4) Parsons Green Health Centre, 5-7 Parsons Green, SW6 4UL
- By Appointment: Mon-Thu 08:00 till 09:45 or Fri 08:30 till 12:30
You need to make an appointment by calling 020 8846 6767.

You will need to fast before the blood tests. This means that you cannot eat or drink anything (apart from
water) for 12 hours before your blood test. You should continue to take any regular medication that you are
on. Please take the enclosed blood test form when you attend for your blood test. We should be able to
discuss the results of your blood tests when you attend for your health check appointment at the surgery.

If you have already responded to a previous letter inviting you to attend for a Health Check, please accept
our apologies for sending you this further letter. If you wish to decline this invitation for a Health Check,
please complete and return the slip at the bottom to avoid us sending you further reminders.

Many thanks for your co-operation

Yours sincerely

| would like to decline this invitation for a NHS Health Check because:

Signed: Date:

Name: ~[Title] ~[Forename] ~[Surname]
NHS Number: ~[NHS Number]



EMIS Sample Letter 3

Patients whose health check is satisfactory

~[Title] ~[Calling Name] ~[Surname]
~[Patient Address Line 1]

~[Patient Address Line 2]

~[Patient Address Line 3]

~[Patient Address Line 4]

~[County]

~[Post Code]

Date : ~[Today...]

Dear ~[Title] ~[Surname]

Your recent health check

Your Patient Number: ~[Patient Number]
Please quote this number
if booking an appointment

You recently attended the practice for a health check. We are pleased to inform you that
your tests results are satisfactory. Therefore you do not need to take any further action at
this time but we would advice you to have a further health check in 5 years times.

Many thanks for your co-operation

Yours sincerely



EMIS Sample Letter 4

Patients whose health check is not satisfactory

~[Title] ~[Calling Name] ~[Surname]
~[Patient Address Line 1]

~[Patient Address Line 2]

~[Patient Address Line 3]

~[Patient Address Line 4]

~[County]

~[Post Code]

Date : ~[Today...]

Dear ~[Title] ~[Surname]

Your recent health check

Your Patient Number: ~[Patient Number]
Please quote this number
if booking an appointment

You recently attended the practice for a health check. | would like to invite you back to the
practice to talk about your test results and discuss future care.

Could you please contact the practice and make a routine appointment for review?

Many thanks for your co-operation

Yours sincerely



3.4

Running a search to identify the patients you will target

It is necessary to decide within your practice how you wish to target the patients that require a
CVD primary prevention appointment. You will then need to run a search to identify a cohort of
patients to whom you wish to send invite letters.

A few possible approaches are as follows:

V. Target all patients on the CVD at risk register right away to maximise your chances
of getting to see everybody before the end of the QOF+ period.

VI. Only target patients on the CVD at risk register who don’t have hypertension.
Modify your processes for dealing with hypertensive patients in order that the
QOF+ CVD primary prevention indicators for any hypertensive patients on the CVD
at risk register are performed as part of your normal process for managing
hypertensive patients. This will help prevent duplication of time/work for patients
who are already getting recalled as part of your hypertension call and recall
procedures

VII. Break your CVD at risk register down into subsets in order to spread out the work
load over the QOF+ period. This might help manage capacity within the practice.
One approach could be to target the higher risk (>30%) patients first

VIIl. An alternative approach to the one above could be to target the higher risk
(>30%) males first

Whichever approach you choose to take, you will need to define a search to identify the patients
that need to be invited for an appointment. To run a search in EMIS complete the following

steps:

a. Go to ST — Search & Statistics » B - Patient searches » A - Build and perform a
new search

b. Select option A — Perform a search on today’s practice population
c. Build your search by adding a series of Features. There are 3 types of features:
i. SHARED: The patient must have this feature be included in the cohort

ii. EXCLUDED: If the patient has this feature they will not be included in
the cohort

iii. EITHER/OR: If the patient has any of the EITHER/OR features they will
be included in the cohort

Below are definitions and screenshots of searches for the four potential
approaches given above:



I. All Patients on the CVD at risk register

Feature

Type

Age:32-74

SHARED, no date range

Classification Code: G3... Ischaemic Heart Disease

EXCLUDED, no date range

Classification Code: C10.. Diabetes mellitus

EXCLUDED, no date range

Classific. Code: 662m. JBS CVD risk >20 — 30% over 10 years

EITHER/OR, no date range

Classification Code: 662n. JBS CVD risk >30% over 10 years

EITHER/OR, no date range
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Il. Patients on the CVD at risk register who don’t have hypertension

Feature

Type

Age:32-74

SHARED, no date range

Classification Code: G3... Ischaemic Heart Disease

EXCLUDED, no date range

Classification Code: C10.. Diabetes mellitus

EXCLUDED, no date range

Classification Code: G2... Hypertension

EXCLUDED, no date range

Classific. Code: 662m. JBS CVD risk >20 — 30% over 10 years

EITHER/OR, no date range

Classification Code: 662n. JBS CVD risk >30% over 10 years

EITHER/OR, no date range
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the CVD at risk register with a risk score >30%

Feature

Type

Age:32-74

SHARED, no date range

Classification Code: G3... Ischaemic Heart Disease

EXCLUDED, no date range

Classification Code: C10.. Diabetes mellitus

EXCLUDED, no date range

Classification Code: 662n. JBS CVD risk >30% over 10 years

SHARED, no date range
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IV. Males on the CVD at risk register with a risk score >30%

Feature Type
Age:32-74 SHARED
Sex: M SHARED

Classification Code: G3... Ischaemic Heart Disease

EXCLUDED, no date range

Classification Code: C10.. Diabetes mellitus

EXCLUDED, no date range

Classification Code: 662n. JBS CVD risk >30% over 10 years

SHARED, no date range
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d. Once you have completed defining your search, press return
e. When prompted whether the features are correct, check them and select ‘Y’
f.  Give the search a clear title, for example:

“Age 32-74, No DM or CHD, CVD Risk > 20%”
g. Choose a directory to store your search in, such as the ‘Regular Search File’
h. When prompted whether to run the search, select ‘Y’

i. The search will run in the background. When it completes, you will receive a
prompt

You have now defined a cohort of patients to whom you can merge an invite letter.

IMPORTANT: If you chose to target only a subset of your CVD at risk register, you will need
to repeat these steps at a later date to target the remaining subsets.

If you require training on the Search and Statistics module of EMIS, or if you require any
assistance defining searches for QOF+, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.5 Merging invite letters

The following steps describe how to merge the invite letter that you defined in Section 3.3 to the
cohort of patients identified by the search you defined in Section 3.4.

a. Goto WP -Word Processing » S — Merge Document with Search

b. Navigate to the search you defined in Section 3.4 and select it

. The system wil launch 3 Selec

Document dialog box. Navigate to the | Laskin [ MSWDacs on Emistazza | &k E3-
letter you defined in Section 3.3 and click | |[©#2weskrue D# allative Care
| # Cardiology |20 # Physio
Open. |2 # Child Psych |CZ)# Respiratory
|Z)# Diabetes |20 # Stop Smoking
IN? | # Gastro I # ¥ray
d. Press ‘N when prompted whether you | =% .. S chid 1M
wish to add a reference to each patient’'s ||, .
record. (This is unnecessary since we Will | Fiepame: |
be adding a Read code to document this | Fiesoryps [RTF Filest ) =] Cancel

in Section 3.6 — if we added a reference
at this stage it would not be Read coded or searchable).

e. Atthe prompt ‘Start from which patient’ press Enter

f. The merge will run in the background. Press any key to return to the Word
Processor screen

g. Go to menu option H — Merge/Search Management

h. Press TAB to view completed merges. (It is possible that you may need to wait a

few moments for your merge to complete)
i. Scroll down to your recent merge and select option O — Open Document

j. The merged document will open in Microsoft Word with each merged letter
appearing one after the other (i.e. if you merged a one-page letter to 200
patients you will have a 200-page document.)

k. Print the document

IMPORTANT: If you chose to target only a subset of your CVD at risk register, you will need to
repeat these steps at a later date to target the remaining subsets.

If you need any help performing the merge described above, or if you encounter problems or
require assistance with the process, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.6

Documenting the dispatch of invite letters in patients’ medical records

The steps below describe how to add the following Read code to patients’ records to document

that a CVD Primary Prevention invite letter has been sent out:

90x1. At high risk of cardiovascular disease monitoring letter invite

The process is similar to the batch processing of risk codes in Section 3.1, except we’ll be merging

to a search, rather than to a manually generated list of patients.

a.

b.

i

Go to AO - Advanced Options » BD - Batch Processing
Click ‘Y’ at the warning prompt
Select option A — Batch Data Entry

When prompted to indicate how you’ll be defining the list of patients to apply
the batch processing to, choose option A — Generated as result of a search

Navigate to and select the search you defined in Section 3.4
Specify the Data Type as option A - Clinical Record

Type the Read code 90x1 At high risk of cardiovascular disease
monitoring letter invite

Click ‘N’ when prompted whether to add the code as an active problem

When prompted to specify the date of entry, select option A — The same for all
the patients and accept the default date

At the confirmation prompt, check the details and press ‘Y’ to confirm (twice!)

The code will have been added to the medical record of all patients who were defined by your

search and will appear as follows:

All Categories Except (Biochem, Haem, Cytology, Micro)

A Add D Delete E Edit F Flow chart R Reactivate
T Template L Linked Consultation C Category filter P Problem fi
N Investigations O Codes on/off K Mark as Summary

Date Description Episode, Text, Qualifiers, e

6.2009 Estimated date of delivery by dates

20.2.2009 At high risk cardiovascular disease monitoring letter invite |
.2.2009 No FH: Hypertension

16.2.2009 No FH: CVA/Stroke

13.2.2009 Chronic kidney disease stage 3A with proteinuria

o

This will enable you to easily run a search to identify patients who have received an invite letter

within a particular period.

If you encounter problems or require assistance with the process, then please log a call with the
IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.7

Data entry during your CVD primary prevention appointments

Practices have been provided with templates specially designed for recording the information

required by QOF+.

Note: If your QOF+ templates have not been installed, then please log a call with the IT Service
Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).

Of the QOF+ templates distributed to practices, there is one titled CVD Primary Prevention

which is intended to allow the recording of the information necessary to perform a CVD Primary

Prevention Assessment. It also includes, as sub-templates, the QOF+ templates for smoking and

for alcohol.

Below are screenshots of the template with some notes and guidance on usage:

late For Primary Prevention Of Cvd

Prompt Result Date Last Recorded Entry
CVD Risk Assess|_ (Y or N) CVD Prevention 9.1.2009
CVD 10-yr risk CVD Risk 21-30% 10.2.2009
Comments:
FH:CHD FH:MI 1d M<55 23.12.2008
Family member Father
Comments:
FH:Diabetes FH:DM 1st Deg 19.12.2008
Family member
Comments:

Prompt

Notes/Guidance

CVD Risk Assess

The prompt was not included in the original distributed template. Adding
it to the template is described in Section 3.2 above. It should be used to
record that a CVD Primary Prevention appointment has been performed
with the patient — it is intended to simplify your call and recall procedures
by being a clear marker of patients who have attended for the assessment.

CVD 10-yr risk

It isn’t intended that you would make any entry at this prompt during
consultation. It is included in the template so that the patient’s most
recent recorded risk is visible on the RHS. (Note that the CVD at risk
register consists of people who have ever had a CVD risk > 20% - if you
wanted to view all historical recorded risk scores, press the PAGE
UP/PAGE DOWN keys when highlighted on this prompt to scroll through
previous recorded data. Press F1 to return to the template).

FH: CHD This prompt has a picking list to choose a FH:CHD code that satisfies the
QOF+ indicator +CVD PREVENT 5. A family member may also be specified
and comments entered if appropriate. Note that if FH:CHD has already
been recorded, it will be visible on the RHS and needn’t be coded again.

FH: Diabetes Similar to the FH:CHD prompt, but for FH: Diabetes. Satisfies the QOF+

indicator +CVD PREVENT 6
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revcnfion Of Cvd

Prompt Result Date Last Recorded Entry
FH:Unknown| (Y or N) FH:Unknown ===
Comments:

Systolic BP 110 5.12.2008
Diastolic BP 60 mm Hg 5.12.2008
O/E - weight 50 Kg 19.12.2008
O/E - height 170 cm 19.12.2008

Body Mass Index 17.3 19.12.2008

Cholesterol 5 MMOL/ L 12.8.2008

HDL Cholesterol .9 mmol/1 1.8.2000
Chol:HDL Ratio Chol:HDL Ratio SRR

Prompt

Notes/Guidance

FH: Unknown

For patients that have no knowledge of their family history, such as people
who have been adopted.

Chol:HDL Ratio
LDL Cholesterol
Serum triglyc.

Fasting glucose

Systolic BP Value codes. Self-explanatory. Satisfy QOF+ indicators +CVD PREVENT 1
Diastolic BP and +CVD PREVENT 2

O/E — weight

O/E - height Note that height need only be recorded once over the age of 18

Body Mass Index Calculated field. No entry necessary

Cholesterol It isn’t intended that you would make any entry at these prompts during
HDL Cholesterol consultation as this data will normally come electronically from Pathlabs.

The prompts are included in the template so that the patient’s most
recent test results are visible on the RHS and so that you can see whether
they need to have test results updated in order to qualify for the QOF+
indicators +CVD PREVENT 3 and +CVD PREVENT 4

late For Primary Prevention Of Cvd

Prompt

Result Date Last Recorded Entry

LDL Cholesterol
Serum triglyc.
Fasting Glucose

LDL Cholesterol
Serum triglyc.
Fasting Glucose

24.11.2008

Dietary advice Health ed. - di
Comments: qym
Exercise advice Health ed. — ex 24.11.2008
Comments: see dietician
Smoking status Never 19.12.2008
Comments:
Prompt Notes/Guidance

Dietary Advice
Exercise Advice

Satisfy QOF+ indicator +CVD PREVENT 7

Smoking Status

Satisfies QOF+ indicator +SMOKING 1. This prompt is included since the
indicator applies to all patients over 15.
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Prompt

Date

Last Recorded Entry

Cessation Advice
Comments:
Smoking referral
Comments:

Except pt: smkq
Reason:

FAST Alc Sc Test
Comments:
AUDIT-C Alc Test
Comments:

Cessation advic 12.2.2009
Cessatn.advisor 13.11.2008
Except pt: smkg
6 points 13.11.2008

4 Score 26.1.2009

Prompt

Notes/Guidance

Cessation Advice
Smoking Referral

Satisfy QOF+ indicator +SMOKING 2. This prompt is included since the
indicator applies to all patients over 15.

Except pt: smkg

Can be used to except the patient from all smoking indicators — both for
QOF and QOF+

FAST Alc Sc Test
AUDIT-C Alc Test

These prompt for values and allow the recording of the score of the
alcohol screening tests for the QOF+ indicator +ALCOHOL 1. These
prompts are included since the CVD at risk register is one of the registers
for which the +ALCOHOL 1 indicator is applicable. If you decide to use only
one of the two available screening tests in your practice then you might

wish to delete one of these prompts from the template

Prompt Result Date Last Recorded Entry

Alc intervention| (Y or N) Health ed. — al 13.11.2008
Comments:

Except pt: alc Except pt: ale @  -———
Reason:

Statins Statin prophyla 24.11.2008

CVD Ass Declined CVD Ass Declined —
Comments:

Prompt

Notes/Guidance

Alc intervention

Satisfies the QOF+ indicator +ALCOHOL 2. This prompt has been included
since the CVD at risk register is one of the registers for which the
+ALCOHOL 1 indicator is applicable.

Except pt: alc

Can be used to except the patient from the QOF+ alcohol indicators

Statins

At this prompt you may choose one of the following options from the
picking list:

Statin prophylaxis: Use this if you issue the patient with a statin, but note
that to actually prescribe the statin you will need to switch to the
prescribing screen

OTC Statins: Use this if the patient purchases statins over the counter at a
chemist or is advised to do so

Statin declined: Use this if the patient is offered statin therapy but declines
Statin not indicated: Use this if statins are not indicated

Statins contraind.: Use this if statins are contraindicted

Statin not tolerated: Use this is the patient reports an intolerance to

statins
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AR statins: Use this if the patients reports an adverse reaction to statins
AR Simvastatin: Use this if the patients reports an adverse reaction
specifically to Simvastatin

AR Pravastatin: Use this if the patients reports an adverse reaction
specifically to Pravastatin

CVD Ass Declined | This prompt will allow you to except a patient from the whole set of QOF+
CVD prevention indicators. It may be used to record that a patient
explicitly declined the offer of CVD primary prevention intervention — i.e.
declined to attend an appointment or be involved in the whole process.

If your QOF+ templates have not been installed, or if you encountered problems installing them
or configuring them or if you require training on using templates in EMIS, then please log a call
with the IT Service Desk (servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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3.8

Recording that patients have declined the invite

If patients explicitly decline the invitation for a CVD primary prevention appointment, they may
be excepted using the following Read code:

8IAC. Vascular disease risk assessment declined

Note that a patient cannot be inferred to have declined on the basis of only one invite letter.
Evidence of three invite letters will be sought where a patient has been excepted using the above
code.
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3.9

Identifying patients who need a second/third invite letter

You will need to follow up your initial invite letter with a second/third invite letter for those

patients that have neither attended for an appointment nor explicitly declined the invitation.

The process will be similar to the process described above in Section 3.4 and Section 3.5, except

that you will need to perform a different search and you may wish to define an alternative letter

template, as in Section 3.3.

Below is the definition and screenshot of a search to identify patients who:

e. Areon the CVD at risk register

f.  Have received a CVD Primary Prevention invite letter, documented using the Read code
90x1 At high risk of cardiovascular disease monitoring letter invite

g. Have not had a CVD primary prevention appointment recorded using the Read code
6C2.. Primary prevention of cardiovascular disease

h. Have not been excepted using the Read code

8IAC. Vascular disease risk assessment declined

These patients will need to be re-invited

Feature

Type

Age:32-74

SHARED, no date range

Classification Code: G3... Ischaemic Heart Disease

EXCLUDED, no date range

Classification Code: C10.. Diabetes mellitus

EXCLUDED, no date range

Classific. Code: 662m. JBS CVD risk >20 — 30% over 10 years

EITHER/OR, no date range

Classification Code: 662n. JBS CVD risk >30% over 10 years

EITHER/OR, no date range

Classification Code: 90x1 At high risk of cardiovascular
disease monitoring letter invite

SHARED, 30/06/08-30/09/09

Classification Code: 6C2.. Primary prevention of
cardiovascular disease

EXCLUDED, 30/06/08-30/09/09

Classification Code: 8IAC. Vascular disease risk assessment
declined

EXCLUDED, 30/06/08-30/09/09

Editing Search Parameters

A Add Feature C Cancel Feature I Insert Feature R Code Review
O Alter Operator X View Exclusions D Alter a Date Range

Feature Date Range Operator
A Currently registered (regular —pd) SHARED
B Aged between 32Y and 74Y SHARED
Z Ischaemic heart disease EXCLUDED
D Diabetes mellitus EXCLUDED
E JBS cardvas risk >20%-30% 10yr INCLUDED
F JBS cardvasc risk >30% 10 yrs INCLUDED
5 At high rsk CVD mon lett invte 30.6.2008 - 30.9.2009HARED
H Primary prevention of CVD 30.6.2008 - 30.9.2009XCLUDED
I Vasc diseas risk assess declin 30.6.2008 - 30.9.2009XCLUDED

If you require training on the Search and Statistics module of EMIS, or if you require any

assistance defining searches for QOF+, then please log a call with the IT Service Desk

(servicedesk@hf-pct.nhs.uk , 020 8383 8655).

14


mailto:servicedesk@hf-pct.nhs.uk

3.10 Identifying patients who have had a CVD Primary Prevention
appointment, but failed to return for fasting blood tests

You may have patients on the CVD at risk register who have attended for a CVD primary
prevention appointment and have had most of the QOF+ CVD primary prevention indicators
completed, but who were asked to return having fasted to have their blood tests performed and
who have failed to do so.

The following search definition would enable you to find patients who:
d. Are onthe CVD at risk register

e. Have had a CVD primary prevention appointment recorded using the Read code
6C2.. Primary prevention of cardiovascular disease

f. Have not had any cholesterol or FBG blood test results recorded

Feature Type

Age:32-74 SHARED, no date range
Classification Code: G3... Ischaemic Heart Disease EXCLUDED, no date range
Classification Code: C10.. Diabetes mellitus EXCLUDED, no date range
Classific. Code: 662m. JBS CVD risk >20 —30% over 10 years | EITHER/OR, no date range
Classification Code: 662n. JBS CVD risk >30% over 10 years EITHER/OR, no date range
Classification Code: 6C2.. Primary prevention of SHARED, 30/06/08—-30/09/09
cardiovascular disease

Classification Codes for Chol, LDL, FBG:

440E. Plasma total cholesterol level EXCLUDED, 30/06/08-30/09/09
44P1. Serum cholesterol normal EXCLUDED, 30/06/08—-30/09/09
44P2. Serum cholesterol borderline EXCLUDED, 30/06/08-30/09/09
44P3. Serum cholesterol raised EXCLUDED, 30/06/08—-30/09/09
44P4. Serum cholesterol very high EXCLUDED, 30/06/08-30/09/09
44P]. Serum total cholesterol level EXCLUDED, 30/06/08—-30/09/09
44PH. Total Cholesterol Measurement EXCLUDED, 30/06/08-30/09/09
44T2. Fasting blood sugar EXCLUDED, 30/06/08—-30/09/09
44g1. Plasma fasting glucose level EXCLUDED, 30/06/08-30/09/09
44f1. Serum fasting glucose level EXCLUDED, 30/06/08—-30/09/09
44dA. Plasma HDL cholesterol level EXCLUDED, 30/06/08-30/09/09
44d3. Plasma fasting HDL cholesterol level EXCLUDED, 30/06/08—-30/09/09
44d2. Plasma random HDL cholesterol level EXCLUDED, 30/06/08-30/09/09
44P5. Serum HDL cholesterol level EXCLUDED, 30/06/08—-30/09/09
44PB. Serum fasting HDL cholesterol level EXCLUDED, 30/06/08-30/09/09
44PC. Serum random HDL cholesterol level EXCLUDED, 30/06/08—-30/09/09

If you require training on the Search and Statistics module of EMIS, or if you require any
assistance defining searches for QOF+, then please log a call with the IT Service Desk
(servicedesk@hf-pct.nhs.uk , 020 8383 8655).
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Section 4:

Frequently Asked Questions about
Processes for CVD Prevention
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What functionality does the Oberoi Clinical Observations Suite Provide?

The Oberoi Clinical Observations Suite extracts data from your clinical system in order to
compute a variety of risk scores for patients. Of the risk scores that Oberoi calculates, the one
that is relevant to QOF+ is the JBS CVD 10-year risk score. Your CVD At Risk Register will be made
up of those patients in the age range 32 — 74 who have an estimated JBS CVD 10-year risk score
greater than 20%.

Oberoi also has a risk score calculator which may be used to experiment with the effect that
modifying lifestyle, serum or blood pressure factors would have on a patient’s risk score.
Additionally, Oberoi can show 5-year risk scores, can summarise what data from a patient’s
record has contributed to their risk score and can compare their current risk with their worst case
historical risk.

Where can | find a User Manual for Oberoi Clinical Observations?

The Oberoi user manual is accessible from the Documents section of the QOF+ intranet site: .
http://www.qofplus.co.uk/more

You may also find it useful to look at the CVD Prevention section in the QOF+ Resource pack,

which you can also find at the QOF+ intranet site.

How can | arrange training for practice staff on the use of Oberoi

Training for practice staff on using Oberoi may be arranged by contacting the IT Service Desk:

IT Service Desk 020 8383 8655

As a rough guide, 1-2 hours is likely to be adequate to demonstrate the functionality of the
product in the context of QOF+.

How can | contact Oberoi for support?

Oberoi support desk 01332 224 251

Direct support from Oberoi will only be provided till the year 2010. Support in using Oberoi is also
available from the local IT Service Desk on 020 8383 8655. Enquiries directly related to QOF+
might be better directed to the local IT Service Desk than to Oberoi.

If | want to use Oberoi on multiple workstations, do | need to install
separate instances of Oberoi on each workstation, each with a separate
database of analysed data?

17



No. Oberoi can be installed on just one workstation as a ‘Virtual Server’ which can be made
accessible from any other workstation in your practice. With this approach you will have only one
instance of Oberoi and only one database of analysed data.

There is more information available about how this option is set up/configured in the installation
instructions available from the Documents section of the QOF+ intranet site:

http://www.qofplus.co.uk/more

If you wish to discuss these configuration options, check how Oberoi is installed at your practice,
require any assistance with the installation or need any help understanding how to use Oberoi as
a ‘Virtual Server’, please contact the IT Service Desk:

IT Service Desk 0208 383 8655

Does Oberoi calculate risk scores for all patients?

Oberoi only calculates risk scores for patients in the age range 32 — 74.

In addition if you have an earlier version of Oberoi than v2.6.14 it will not calculate risk scores for
patients who don’t have any recorded blood pressure readings in their medical record.

How can Oberoi calculate a risk score for patients without any BP
readings or Cholesterol values in their notes?

In agreement with NICE Lipid Modification Guidance 2008, Oberoi uses default values where data
is missing from patients notes.

Where patient data is missing for cholesterol, an estimated risk score is calculated using default
values for HDL and Total Cholesterol.

Where patient data is missing for BP, an estimated risk score is calculated using default values for
BP. The default values for BP are displayed in the table below:

Age Default Systolic BP
Males Females
16-24 128 120
25-34 131 121
35-44 131 123
45-54 136 130
55-64 140 138
65-74 147 137
75-84 151 155
85+ 149 151

Please note that only a patient’s systolic blood pressure reading is used in the CVD/CHD risk
algorithms.

http://www.pcpoh.bham.ac.uk/publichealth/cardiovascular/
- select: List of Default Blood Pressures and Cholesterol Levels

http://www.pubmedcentral.nih.gov/articlerender.fcgi?artid=2244603

18


http://www.pcpoh.bham.ac.uk/publichealth/cardiovascular/

Why does our clinical systems sometimes shows different risk scores
compared to estimated risk scores from Oberoi, even though they use
the same algorithms?

The reason for this is that the clinical systems use differing default values for Cholesterol.
However Oberoi has validated the risk scores against standalone online risk calculators.

Which risk score Read codes are used by Oberoi and which of these are
relevant to the QOF+ CVD At Risk Register?
The following risk score Read codes are used by Oberoi:

e 662k JBS CVD Risk < 10% 10 yrs

e 662l  JBSCVD Risk 10%-20% 10 yrs

e 662m JBS CVD Risk > 20% - 30% 10 yrs

e 662n  JBS CVD Risk >30% 10 yrs

e 3888 Framingham CHD 10 year risk

Of these risk score Read codes, the ones that are relevant to QOF+ are the two codes highlighted
in bo

Id —these are the codes that would be used to constitute your CVD At-Risk Register.

| am not sure how | feel about inserting an estimated CVD risk score into
a patient’s notes, rather than a calculated risk score.

We can understand why you might feel this way. However the insertion of an estimated CVD risk
score (>20%) into the patient’s notes helps create a ‘virtual register’ of patients suitable for
targeted screening. This process is incorporated into the approach suggested by the Oberoi
software, which is used across the country. Originally the software even inserted the code into
the patient’s notes for you. On a clinical level, all CVD risk calculations (whether estimated or
‘calculated’) are forms of ‘estimates’ and are imperfect to differing degrees. Indeed NICE debated
a lot about which CVD risk formula to adopt for the Lipid modification guidance.

In addition, it is expected that after screening tests are arranged, clinicians will calculate an
‘actual’ risk score which is then inserted into the notes as a Read code. This will become the most
recent risk score entry in the patient’s notes which will help govern future management of that
patient. It is also only fair to say that Oberoi is not an ideal tool. Unfortunately, there is no better.

The F3 function key allows me to configure risk factors in Oberoi. How
should | configure these risk factors?

We are advising that risk score factors in Oberoi be configured as follows:

1  The risk factor associated with a Family History of CVD should be left at the default value
of 1.5.

2 The risk factor for all ethnic groups should be left at the default value of 1.0. This is
because Oberoi versions 2.6.14 and earlier may incorrectly over-estimate the CVD risk
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for patients who have a family history risk factor and an ethnicity risk factor combined.
To avoid any further confusion to practices (who might not be sure which version of
Oberoi they are using), we have suggested not to adjust the ethnicity risk factors.

Which existing disease register patients should not get added to the CVD
At-Risk Register?

Patients with CHD or diabetes should not be added to the CVD At Risk Register. When the data
from Oberoi is exported to Excel, you can filter out patients with CHD or diabetes.

Should patients with hypertension be filtered out of the list of patients
that need to be added to the CVD At Risk Register?

No. Patients with Hypertension who have a 10-year CVD Risk Score > 20% should be added to the
CVD At Risk Register and these patients will be monitored against the QOF+ indicators. You may
feel that you do not need to invite your hypertensive patients for review as your practice already
has a robust recall and review system for these patients. If this is the case, you have the option on
Oberoi to filter out the Hypertensive patients from the Excel spreadsheet. However we would
strongly recommend that you check if your existing review of Hypertensive patients is extensive
enough to cover the QOF+ indicators for CVD Prevention. Furthermore, it should be noted that
even if you choose to exclude hypertensives from your CVD Prevention call/recall processes,
these patients still need to have their risk scores coded if they are > 20%.

What are the implications for a patient having a risk score added to their
medical record without being informed first?

It is likely that as soon as a practice enters a risk score in the patient’s records, that patient
will be sent an invite for CVD screening so the patient is ‘being informed’.

Is it possible to code risk scores directly into patient records from within
Oberoi?

Some limited functionality within Oberoi to assist with coding risk scores directly into patient
records has been restored to recent versions (2.6.19) but risk scores might still need to be
entered manually into patient records using the processes shown in this guide

People coded with risk more than 20% may, after modification (e.g. with
a statin), drop off the register because their risk drops below 20%. Are
you suggesting that once on the register a patient shouldn’t be removed
from it — which would mean the code potentially becomes ‘incorrect’ the
day after it is added or alternatively are you suggesting that once a
persons risk score drops below 20% that the code is removed and they
drop off the register and the practice is not ‘paid’ for this positive
outcome?

All data entered in medical notes could be viewed as only as accurate as when it was
entered. We are suggesting that once a patient is on a CVD at risk register, they should not
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be removed. This actually does make clinical sense as even if you reduce their risk (by
intervention), they still need future review to monitor their risk as their risk may increase
again (similar approach to other chronic conditions such as diabetes, CVD). However we
recommend that a clinician reviews the notes of the identified patients before entered the
estimated CVD risk >20% in their notes in case there is an obvious error — e.g. actually patient
is a diabetic who has not been read-coded correctly, mistyped BP of 999/50 (has happened

at one practice) etc.

In some ways, NICE suggests viewing ‘CVD At-risk’ more like a condition. You do not have to
worry about reducing the risk and then not being paid! We already thought of this possibility
so the complicated QOF+ Business Rules address it. Payment will be based on the presence
of a CVD risk >20% code (without presence on diabetes/CHD register) irrespective of whether
there are subsequent lower CVD risk codes in the notes. We also did not feel it would be fair
if practices screened those CVD>20%, did some hard work to reduce the patient’s risk and

then not be paid as a result of their work!

You may also find the answer to your question in the separate QOF+ FAQ document, which you can obtain

from:

http://www.qofplus.co.uk/more

Got a question that isn’t listed here? Let us know!

gof+@hf-pct.nhs.uk



